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1. Installing the website 
You may find below information about the Jobs Portal integrated web 
installer, the description of the different steps during the installation, 
possible errors and troubleshooting information.  

The installation is quick and easy, it passes through just 3 steps – 
agreeing with the license agreement (and / or entering the license key, 
depending on the setup), entering the MySQL information (server, user 
name and password) and selecting the database to be used for the in-
stallation. 

Please note also that we offer free installation for all our products, so in 
a case you prefer that we do the installation for you, you just need con-
tact our support team and we'll do it as soon as possible for you. 

Step 1 - Welcome screen and Jobs Portal end user license agreement 
 

In this first step you'll be able to: 
• see the  setup welcome message 
• read the Jobs Portal end user license agreement 
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In order to continue to the next step, you'll have to  agree with the 
Jobs Portal end user license agreement by clicking on the check box 
(“I agree ...”). 

Depending on the setup, which is used, during this first step you may 
be also asked to enter the license key obtained during your purchase. 

Step 2 – Entering the MySQL server information (MySQL server, user-
name and password) 

During this step you'll be asked to enter the MySQL server information 
(the server name, MySQL user and password) of your host. The setup 
needs this information in order to setup  the MySQL database used by 
the Jobs Portal software.  
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You'll see a screen with the following fields: 

- MySQL Server, the server where you plan to install the database, usu-
ally “localhost” for most of the hosting companies  

Please note that on some hosting companies like GoDaddy, the MySQL 
server name may be specific for every database, which is created and 
may look like for example: db_name.db.11111.hostedresource.com 
In such cases it's necessary to copy and paste the exact server name, 
which you may find in the hosting package control panel and the Data-
bases tab there. 

- MySQL username and password  

On most hosting package, you'll need first to create a new MySQL user 
and database from the hosting package control panel, so it's up to you 
to choose the password and usern you prefer for them. 

Please note that on cPanel hosting package (used by the most popular 
hosting companies like HostGator, BlueHost, HostMonster, CirtexHost-
ing etc.) if you create a new database and MySQL User you need to ex-
plicitly give permissions to this user for the database you created – you 
can do that from the MySQL Database page in Cpanel, at the bottom. 
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If you are not sure for these settings, please contact your hosting 
provider or log in to your hosting package control panel, where usually 
this information can be found on a page called “MySQL” or “Databas-
es”. 

After you enter this information and click on the Continue button, the 
setup will try to connect to the MySQL server with the user name and 
password you entered. If any of values aren't correct like (the address 
of the MySQL server or the MySQL user name and password), then an 
error message will be displayed and you won't be able to continue un-
til you enter the correct values. 

Troubleshooting 

 1. After you click the Continue button you receive an error message 
in red saying “Server doesn't exist or access is denied”. 

If this is the case, please check again the values you have entered. If 
the problem persists:  

 make sure that your MySQL server is up and running and that this 
account is valid 
 make sure also you enter a correct MySQL server name (on 
companies like GoDaddy and 1&1 the name isn't the default “lo-
calhost” and may be different for every database)  
 on cPanel hosting packages, please check if permissions for the 
database are granted to the MySQL user you entered 
- if you have any troubles finding the correct MySQL information 
for your hosting package, you can also contact your hosting 
provider and ask them for the MySQL settings for your hosting ac-
count 

Step 3  - Setup of the main Jobs Portal database 
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In this step you'll be asked if you would like to create a new database 
for Jobs Portal or use an existing one.  

If you choose the option to create a new database, you'll be asked to 
enter the name of the database. We recommend you to use a name, 
which will be easy to distinguish, like for example jobs_portal. Be 
aware that when choosing this option, the MySQL user you have pro-
vided in the previous step should have the permissions to create new 
databases on the MySQL server. If this is not the case, the database 
creation will fail and such error will be displayed on the screen. 

If you choose the option to use an existent database, the Jobs Portal 
database tables will be created in the database chosen by you. All the 
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tables, which will be created will have a prefix “jobsportal_”, no data 
from the existing database and tables will be deleted.  

Troubleshooting 
 1. I have selected the option to create a new database but when I 

click on Continue, I get an error message colored in red and I can't 
proceed to the next step, why? 
- make sure that your MySQL user has “CREATE DATABASE” permis-
sions on the MySQL server 
- make sure that you don't have already a database on your server 
with the same name as the one you entered 

 2. I have tried to use the second option, to use an existing data-
base, but I receive an error message saying that the table “job-
sportal_admin_users” already exists 
- this means that you have previously installed the script using this 
database, so you may either use a new database or delete the old 
script tables and then continue with the installation 

Be aware that during this step the setup creates also the script configu-
ration file. If the process running PHP on your server for your hosting 
package doesn't have write permissions for the folder where you in-
stall Jobs Portal you'll receive the following message in the interface: 

The process running PHP on this computer doesn't have permissions to 
create and write the  configuration file in the main web folder. You need 
to create it manually – the content will show up in the screen. You need 
to copy / paste it in a file “config.php” and upload it in the main web 
folder (the one in which you uploaded the real estate files). So you 
could either upload it with FTP or use the File Manager in your hosting 
package control panel to save the config.php file. 
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If you experience troubles when doing this or have any additional 
questions, please don't hesitate to contact us or request our free instal-
lation service. 

Step 4 – Installation successful screen 

If you reached this step, Jobs Portal has been installed successfully on 
your server/hosting package and you can open now the front site and 
also the administration panel to manage the website and different set-
tings. 

2. Configuring the website 
The Settings category in the administration panel and the different 
pages and options there allows you to manage the configuration op-
tions of the website like the jobs expiration time, currency, time zone, 
payment options, job categories, locations and others. You may find 
below a list and description of the different configuration options and 
settings pages. 
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The Settings category contains the following pages: 
•  Configuration Options (on which you may find and set the 

general website configuration options) 
•  Payments (allowing to set the charging modes and configure the 

different payment settings) 
•  Job Categories (allowing to modify the current job categories 

shown on the website) 
•  Locations (change the locations and regions shown on the site) 
•  Banner Areas (allowing to create and configure special banner 

zones / banner areas in which the users can upload banners for 
a fee) 

•  Field Values (modify the possible values of the job seeker fields) 
•  Job Feeds (configure the different job feeds – Indeed, Sim-

plyHired and CareerJet and their usage on the website) 
•  Course Categories (change the categories of the courses – 

shown on the Courses page on the front site and users admin 
panel when posting course listings) 

2.1. Configuration options 

The Configuration Options page allows to change the basic settings 
like the system email address, url format and others. Please find below 
information about the different settings and configuration options 
shown on this page. 

Facebook Page URL, Twitter Page URL, Google+ Page URL 
In these fields you can enter the urls of your Facebook, Google+ or 
Twitter pages, which will show then as icons / links in the Connect With 
Us section on the website 

Jobs Expire Time (Days) 
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With this setting you can control the number of days in which the job 
listings posted on the website will expire. The default value is 30 
(meaning the posted ads will expire in 30 days), but you can easily 
change it with another number of days you may prefer. 
If you set it to: -1 , then the job ads posted on the website will never 
expire. 

Enable SEO URLs  
The search engines optimised urls look like static html pages and have 
keywords in the url (which allows better indexing by search engines 
like Google). 
In order to use the SEO links, the system will require the presence of 
the mod_rewrite module (for Linux / Apache or isapi_rewrite for Win-
dows / IIS). If this module is not available on your server or hosting 
package, you could deactivate this feature by setting it to NO. 

System Email Address 
The email address, which will appear as sender of the system emails of 
the website. Please note that most hosting companies allow to set just 
a sender using the same domain name. So for example if your website 
is installed on yourdomain.com, the system email address should be 
whatever@yourdomain.com and if specifying an email from a different 
email provider like whatever@yahoo.com they may not send the 
emails 

System Email From Field 
The name of the sender of the system email address, usually your 
website name or company name. 

Send email to new users 
If set to yes, then welcome emails will be sent to the new users signing 
up on the website. 

New employer user email subject, New employer user email text 
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If you set the website to send welcome emails to the users, using these 
settings you can set the title and text of the welcome emails, which will 
be sent to the new employer users. 

Number of results per page  
By changing the value of this setting, you can control how many list-
ings will show up on the job result pages shown after an user makes a 
search or browse a category etc. 
The default value is set to 20, meaning that 20 jobs will be shown per 
page. 

Website date format string    
By entering a valid PHP date format string, you can change the format 
of the date displayed on the website. 
Full information on the supported date format strings can be found on: 
http://www.php.net/manual/en/function.date.php 

Here are a few examples: 
"F j, Y, g:i a" // March 10, 2001, 5:16 pm 
"m.d.y" // 03.10.01 
"j, n, Y"  // 10, 3, 2001 
"H:i:s"  // 17:16:18 

Number of listings in Featured section   
Use this setting to control the number of featured listings, which will 
show up in the Featured Listings section to the right. Please note that if 
there are featured listings on the website than the available positions 
(number you set in this field), then the featured listings will show up 
randomly in the Featured Listings section 

New job seeker user email subject, New job seeker user email text 
If you set the website to send welcome emails to the users, using these 
settings you can set the title and text of the welcome emails, which will 
be sent to the new job seeker users. 
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Use CAPTCHA images to prevent spamming   
A good way to avoid automatic form submissions when creating a web 
form is to add some kind of verification. One of the best ways is to use 
an image verification, called also captcha. What it does is to dynamical-
ly create an image with a random string displayed on it. Then visitor is 
asked to type that string in a text field and once the form is submitted 
it checks if the string on the image matches the one inputted by the 
user. 
The usage of the captcha images is enabled by default, but if you 
would like to disable it (for example if the PHP graphics library - GD 
isn't installed on your website), you could change the value of this set-
ting to “NO”. 

Website time zone   
With this setting you can change the default time zone on the website. 
The time zone coming by default for most of the downloads is Europe/
London. 
List of the supported time zones can be found on: http://www.php.net/
manual/en/timezones.php 

Some examples of supported time zones are: 

America/Buenos_Aires  
America/Chicago  
America/Los_Angeles  
America/Mexico_City  
America/New_York 
Asia/Singapore  
Asia/Tokyo 
Europe/Berlin  
Europe/Madrid  
Europe/Moscow  
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Europe/Zurich  
… 

SEO text to be appended to the job category page title   
When clicking on a category, the default page title will be the category 
name. By adding custom text in this field, you can customise the titles 
of the category pages, which will be then the Category Title + Your 
Text (so in this way you can create unique titles for better search en-
gines optimisation). 
   
SEO text to be appended to the job category page meta description  
By adding a text in this field, you can add a text, which will be append-
ed to the default meta description for SEO purposes.   
   
SEO text to be appended to the job category meta keywords   
By adding a text in this field, you can add a text, which will be append-
ed to the default meta keywords for SEO purposes.   

Show number of jobs in category   
If set to YES, will show the number of posted jobs in the category like 
for example Category Name (15). Please note that when the website is 
configured to use job feeds like indeed, except  the jobs posted on the 
website, when clicking on a category the users will see also the jobs 
provided by indeed – in this case the number of jobs shown for the 
category will be only the number of jobs posted on the website itself 
(not total jobs, which will be taken from indeed.com etc.). 

Enable ZIP field, Enable ZIP distance search 
These options allow to show or hide the ZIP field and ZIP distance 
search (available by default for the US and UK on request). For other 
countries these options may be turned off or just the ZIP field to be left 
(it can be renamed also to Post Code or other field name in the lan-
guage file). 
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Enable Facebook Login, Facebook APP ID, Facebook Secret 
Using these settings, you can enable the Facebook log in feature on 
the front site and set your Facebook APP ID and Secret (it's a Facebook 
requirement to register your website with them and get an application 
ID and secret before the log in system could be used on your website). 
Please visit our the online knowledge base in the support section of 
our website to find a visual guide on how you could register your site 
on Facebook and get an application ID and secret 

Enable Twitter Login, Twitter Key, Twitter Secret 
You can use these settings to enable the Twitter log in on the website 
and set the Twitter key and secret required by Twitter. 
To create a new Twitter key and secret for your website to be used with 
the Twitter log in system, it’s necessary to fo to https://dev.twitter.com/
apps/new and there log in, if necessary. 
On this page you have to enter the Application Name (you can enter 
for example your website name or another name you prefer), Descrip-
tion and your website url. The you have to submit the form by clicking 
the Create your Twitter Application and on the next screen you’ll see 
the key and secret that you can copy in these fields in the Jobs Portal 
administration panel 

Enable LinkedIn Login, LinkedIn Key, LinkedIn Secret 
Similar to Facebook and Twitter, LinkedIn also requires the you create 
an application for your page in order to use their log in system. To cre-
ate an application and get your key and secret for it, you have to go to 
https://www.linkedin.com/secure/developer  and there log in with 
your LinkedIn account, click on Create a New Application and follow 
the steps - the key and recreate will be generated on the last step and 
you can copy them in the corresponding fields on the Configuration 
Options page in the admin panel. 
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2.2.   Setting the payments and payment options 

You can choose between 3 main methods to charge the employers – 
based on credits (the users buy credits and then spend them to pay to 
pay for the different services on the website), based on subscriptions 
(the employers can choose a subscription and pay then for example a 
monthly fee and be able to list up to some number of jobs), direct 
payment (as soon as the employer posts the job, he sees for example a 
PayPal icon) or alternatively choose the website to be free for all users 
and in such case the users won’t be charged when posting jobs or us-
ing the other services offered on the website.  

The administrator is able to select one between these 4 types he 
prefers from on the Settings → Payments page in the admin panel. 
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How would you prefer to charge the employers? 

Using this setting you can set your preferences if you would like to 
charge the employers using subscription or using credits or with direct 
payments or if the site should be free for all users. If you choose to 
charge them with subscriptions (recurring payments), you can create 
different subscription packages with different number of allowed max-
imum ads, featured ads and banners included in them and different 
pricing and let the users choose the subscription they prefer. If using 
the credits method, the employers need to purchase credits and they 
can spend after these credits to pay for the different services offered 
on the website. When choose the direct payment options, the employ-
er immediately sees an icon to make a payment when for example 
posting a job etc. 

Website currency 
By default this setting is set to the US dollar sign “$”, but you may 
change it to another one you prefer (like CHF or €).  This will change 
the currency symbol displayed next to the prices on the website. 
This applies for all the prices of the listings on the website, pricing for 
posting listings and banners etc.   
   
Currency Code   
The PayPal currency code if the PayPal system is enabled. By default it's 
set to USD (US dollars), but can be changed to any other valid PayPal 
currency code like EUR, GBP etc. 

You may find below the currency codes for some of the most popular 
currencies supported by PayPal: 

Australian Dollar  AUD  
Brazilian Real   BRL 
Canadian Dollar   CAD 

  Jobs Portal User Manual, Page �17



  NetArt Media 
  August, 2015

Czech Koruna   CZK   
Danish Krone DKK   
Euro EUR   
Malaysian Ringgit   MYR   
Hong Kong Dollar HKD 
Mexican Peso   MXN   
Norwegian Krone NOK   
New Zealand Dollar NZD   
Philippine Peso PHP   
Polish Zloty PLN  
Singapore Dollar  SGD   
Swedish Krona   SEK   
Swiss Franc CHF 
Thai Baht  THB 
U.S. Dollar  USD  
   
PayPal ID  
When the PayPal system is enabled, in this field, the administrator/
website owner has to enter the PayPal account (registered PayPal email 
address) he would like to use to charge the users on the website. 
    
2checkout ID  
When the 2checkout system is enabled, in this field, the administrator/
website owner has to enter the 2checkout SID  (Seller ID) of the 
2checkout account he would like to use to charge the users on the 
website. The seller id can be obtained from the 2checkout website 
(during a new registration for the new users) or from the admin panel 
for the registered ones. 
    
Cheques address   
In this field the administrator has to enter the address, which has to be 
used for the cheques to be sent if the cheques payment options is en-
abled on the website. 
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Bank account information   
In this field the administrator has to enter the full information for the 
bank account to be to be used when the bank transfer payment option 
is enabled on the website. 
   
Amazon Payments ID, PayFast ID, InterKassa ID, Google Checkout ID, 
Skrill/Moneybookers ID , PayMate ID 
To enable any of the following system in order to charge the users, it's 
enable to enter your ID for them in the corresponding text fields on 
the Configuration Options pages. 
If you wish to disable any the systems in the future, it's necessary to 
simply delete the corresponding ID. 

2.3. Job and course categories 

 

The job categories should be set as a list with leading numbers show-
ing their hierarchy, for example: 
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1. Some Main Category 
1.1. Sub Category of the Main Category 
1.2. Another Sub Category of the Main Category 
... 
2. Another Main Category 
... 

It's not required that the numbers are in successive order, so it can be 
possible for example to have -  

1. First Category 
49. Second Category 
3. Third Category 

If you have more than one language added on the website, you'll see 
separate text areas allowing to enter separately the categories for the 
different languages on the site. 

2.4. Modifying the locations 
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Similar to the job categories, the locations can be set as a list with lead-
ing numbers showing their hierarchy. By default up to four levels of lo-
cations as supported, so you may have for example Country – State – 
City – Neighborhood. 

2.5. Changing the default field values 

 

This page allows to set the values of some of the basic fields available 
for the job seekers to create their resume or set their job preferences. 
Please note that when setting the new values, you can use words from 
the language file or enter the value in plain text, for example if you use 
M_FULL_TIME the system will search for the word  M_FULL_TIME in the 
language file (for example include/texts_en.php for the default English 
language with M_FULL_TIME set to “Full Time” there) and will display 
Full Time. 
If you don't use multiple languages on your website, instead of using 
words from the language file you may simply enter the text “Full Time”. 

2.6. Configuring the job feed usage 
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Using the Settings → Job Feeds page, you can configure the different 
job feeds used on the website. You can choose between displaying 
one main feed (like for example to show only indeed jobs on the site) 
or to mix and show different feeds. Please note that all these systems 
require that you first sign up with them, get a partner ID that you can 
set on this page in order to activate the feed on the site and start dis-
playing jobs. 
You may find more information about the different partner programs 
and their conditions on the respective sites of the companies. For ex-
ample for indeed, please visit http://www.indeed.com/publisher and 
to create an account please click on the big blue Create an Account 
button there, as shown on the screen shot below: 
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2.7. Configuring the banner zones on the website  

The Banner Areas functionality allows the administrator to create spe-
cial banner zones / banner areas in which the employers can upload 
their banner for a fee. 
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There are no limitations for the number of the different banner areas 
the administrator can create and for every banner area, he can set the 
banner width and height, position and price. 

When adding a new banner area, the administrator has to enter its 
name and description, the banner area position (there is a choose be-
tween Side Column - the banners will be displayed in the side / right 
column of the site, Top and Bottom), number of rows and columns (if 
setting for example 2 rows X 6 columns, the banner are will be able to 
display up to 12 banners in 2 rows and 6 columns), width and height 
(the width and height of the individual banners added in that area) and 
the number of days in which the banners added in this area will expire. 
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3. Administration panel 

When creating the software, we tried to design and create an adminis-
tration panel, which is as user friendly as possible and gives quick ac-
cess to all the settings and ads management pages. 
The administration panel is responsive and mobile friendly (adapting 
to the different screen sizes) and is also using tiles to make easier 
working with it when using touchscreens.  

 

3.1. General overview 

The administration panel is the main tool available for the Jobs Portal 
website administrator to manage the website, change its settings, 
page content, see the registered employer and job seekers, the jobs 
posted on the website, modify the templates and others. 

The features in the admin panel are divided in categories. The main 
administrator and the members of the Administrators group have ac-
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cess to all the categories and pages in them.  

The Jobs Portal administration panel functionality is divided in 8 cate-
gories / menus in the main start menu:  
 
- Home (welcome / dashboard page, modification of password, log in 
report)  
- Jobs (management of the job listings, applications, job alerts and 
others)  
- Users (employers and job seekers management, adding custom 
fields for the users) 
- Settings (management of the locations, configuration options and 
others)  
- Site Content (front site structure and content management, naviga-
tion menu settings)  
- Extensions (custom extensions and extension files and different 
modules)  
- Templates (front site templates management)  
- Statistics (reports and referrals for the website visits)  
- Admin Users (management of the administration panel users, groups 
and permissions)  

3.2. Main pages in the administration panel 

You may find below a quick overview and brief information about the 
most used pages in the administration panel and functionality on it. 

Home → Welcome 

The Welcome page in the administration panel provides quick infor-
mation about the new listings waiting to the approved and statistics, as 
well as links to the main pages in the administration panel for easier 
navigation. 
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Home → Log in Report 

The log in report shows a log of the administration panel log in at-
tempts – the successful and failed log ins with their date and IP ad-
dress. 
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Home → Change Password 

This page can be used to change the password of the user for the ad-
ministration panel. To change the password it's necessary to enter the 
old password and the new one and confirm it – after the password is 
changed successfully, the user will be logged out and asked to log in 
again with his new password. 
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Jobs → Job Ads 
 
The page allows to see the jobs posted by the users, modify or delete 
them. 

Jobs → New Job Ad 
 

Using this page, the administrator is able to post a job for a selected 
employer. 
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Jobs → User Messages 

The page allows to see the messages exchanged by the users and 
moderate them. 

Jobs → Job Alerts 

 

The Job Alerts functionality can be used by the job seeker to create 
email alerts and be notified by email when a new job meeting their 
search criteria is posted on the website. 
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Jobs → Fields 

 

Using the functionality on this page, the administrator can add new 
custom fields for the job ads – these new fields will show up then on 
the forms for posting new jobs and also on the main site when seeing 
the job details. 

Jobs → Applications 
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The page allows the administrator to monitor the job applications for 
the different jobs posted on the website. 

Jobs → Uploaded Files 

 

On this page, the administrator can see the files uploaded by the job 
seekers and also download any of them if he prefers so. 
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Users → Employers 

The page allows the administrator to monitor the employers and re-
cruiting companies registered on the website and modify their profile 
information. 

Users → Job seekers 

 

The page shows a list of the registered job seekers on the website with 
links allowing to modify their information and see their resume. 

Users → Job seeker Fields 
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Except of adding custom fields for the job ads, the administrator is 
also able to add custom fields for the job seekers – the new fields will 
show up on the job seekers registration page and also on the page in 
the job seekers admin allowing them to change their profile informa-
tion. 

Users → Employer Fields 
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he page makes possible for the administrator to add custom fields for 
the employers / recruiting companies signing up on the website. 

Settings → Configuration Options, Payments, Job Categories, Loca-
tions, Banner Areas, Field Values, Job Feeds, Course Categories  

The page has many different options that you can use to configure 
your website in the way you prefer – set your timezone and currency, 
configure the preferred payment options and many others. Please find 
detailed description of the different settings in “2. Configuring the 
website” 

 

Site Content → Management 
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This is the main page to be used to manage the website structure and 
content – add new pages, remove or rename the current ones, modify 
the pages content, the page title meta keywords or meta description 
or set custom php extension to be executed for a page. 

Site Content → News 
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Site Content → Language Versions 

If you would like to run a multi-language website, it's necessary to add 
the additional languages from this page in the administration panel. 
Please note when you a add a new language, it's necessary to upload 
also the language file for it in the /include folder on your website. 
Please refer to the “Languages and language files” for more informa-
tion and description of the language files and languages manage-
ment. 

 
Extensions → Files 

The page shows the current files in the /extensions folder, which can 
be used for extensions of the pages or custom tags. Please note that 
files that should be used for custom tags have _tag at the end of their 
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name. A file can be set to be executed as extension for a page from 
the Website →  Management page and for a tag from Extensions → 
Tags 

 
Extensions → Tags 

You can use this page to see the current tags, delete any of them or 
add new tag. Please check the chapter “Custom Tags” to read more 
about their usage and functionality. 
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Extensions → FAQ Manager, Extensions → Newsletter 

These are some basic modules loaded by default from sour site man-
ager content system allowing to post news on the website, create a 
page with frequently asked questions and send newsletter to the users 
who have subscribed for it. 
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Templates → Modify, Templates-> Select a Template, Templates → 
Add a New Template 

These pages can be used to modify the front site template, select a dif-
ferent template or add a new template by pasting its HTML code.  

For more information about the templates and their structure, please 

check the section “Templates Management' in this manual. 

Statistics → Reports 

The page shows brief information about the website visits and also 
displays a chart for them. 

Please note that the integrated website visits tracking and statistics in-
formation is basic and simple, for more advanced tracking and infor-
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mation, we recommend using an external system such as Google Ana-
lytics, which can be easily added on the website. 
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Statistics → Referrals 

You can see on this page the last referrals, so you can easily track who 
is linking to your website and from where the traffic to your website 
comes from. 

Users → User Groups, Users → New User, Users → User Permissions 

Using these pages, you can add new administrator users to your web-
site, put them in groups and set their permissions. This can be useful if 
you would like to have multiple users working on the website with 
permissions limited to just some selected pages. For example have a 
News Administrators group with permissions to access only the News 
Management functionality in the administration panel etc. 
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4. Website structure and content 
management 

The functionality, different menus and options on the Site Content → 
Management page allow the administrator to manage the website 
structure – add new pages, rename or remove the existing ones etc. 
and also manage the content of the website, edit the content of the 
different pages, set extensions to be executed for them and others. 
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4.1. Structure management, adding new pages 

Changing the front site pages meta title and description 

In order to change the front site pages meta title, keywords or descrip-
tion, the administrator has to log in in the admin panel and go to the 
Website->Management page.  
On this page, he will see the available website pages as a tree. He  has 
to left click with the mouse on a page in order to select it and then 
choose from the Context menu which will show up “Page Settings”. 

 

A new page will show up containing various page fields including also 
the page meta title description. The administrator has to enter the new 
values and click Save. 

Adding new pages to the website 
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The Jobs Portal admin panel offers  the possibility to freely edit the 
website structure – add, edit or delete the pages  of the front site. 

Please note that you need to define the website structure separately 
for the different language versions available (you could switch be-
tween the language versions by selecting the language from the big 
drop down menu at the top of the Website → Management page). 
In order to add a new page to the front site you need to click on the 
New Page button at the top of Website → Management 

 

This will enter the form for adding a new page -  
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with the following fields: 

- Link Text , the name of the link, which will show up in the main naviga-
tion menu 
- Page Type, it can be either a main page or a sub page of an already 
existing page 
- Title, the title of the page, which will show up in the title tag 
- Meta Description, the meta description of the page, which will ap-
pear in the meta description tag to be used for search engines opti-
mization purposes 
- Meta Keywords, the meta keywords of the page, which have to be en-
tered as a list and will appear after that in the meta keywords tag on 
the page, to be used for search engines optimization purposes 

Changing the pages hierarchy 

You can modify the front site pages hierarchy by clicking on the 
Change Hierarchy button at the top of Website → Management  using 
the form at the bottom of the Website->Management page. 
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This will open the change hierarchy form - this form there allows to 
make a page of the website either a main page or a sub page of an ex-

isting main page. 
Changing the position of two pages 

By changing the position of 2 pages, you'll change the order of the 
pages in the main navigation menu (for example replace the positions 
of the Home and About us pages). 

Near every page on the Website->Management page, you could see 2  
arrows indicating the up and bottom directions, you have to click on 
them in order to change the position of the pages. 

 

Please note that you can change the position of 2 pages only if they 
are on the same level in the website hierarchy (for example main 
pages, or sub pages of the Home page etc.) 
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4.2. Modifying the content of the pages 

The content of the pages can be modified from the Website->Man-
agement page in the admin panel. On this page, the administrator see 
the pages as a tree. 

If the website is multi language, you need to choose the language ver-
sion to manage by using the drop down to the left on Website → Man-
agement - this will switch between management of the pages of the 
different language versions.  

Please note that if you would like to modify the content of a page and 
the website is multi language, you need to do this for every language. 
For example modify the “Contact” page in the English version, then 
the “Contacto” page in the Spanish version etc. 

To edit the content of a page like for example the Contact us page, the 
administrator has to click on it  and then choose either “Launch WYSI-

WYG editor” or the “Edit HTML code” option.  
When using the Edit the HTML code option, you will be able to directly 
modify the html code of the page, while with the first (Edit the page), a 
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WYSIWYG (what you see is what you get) editor will open, allowing to 
modify the content of the page. 

 

Please note that the pages for which php files are set to be executed 
(the “Set Custom Extension” option) can't be modified directly with the 
WYSIWYG editor. These pages can be easily distinguished on the 
Website->Management page, near their name one could see with red 
font the name of the php file to be executed, for example for “Latest 
Links”  this is “latest_links.php”. 
The reason is that the code for these pages is rendered by the system, 
for example in the case of the Latest Links page, it's generated by the 
file /extensions/latest_links.php (which is the jobseekers sign up form), 
so the php code for it can't be modified with the WYSIWYG editor. 

The page can be modified by editing directly the file for it or if only 
some texts need to be changed, this may be done by modifying the 
language file (/include/texts_en.php for English). 

4.5. Languages and language files 
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The language files contain the text and words shown on the user inter-
face. For every language there is one language file located in the /in-
clude folder. 
The name and location of the language file is: /include/texts_[CODE 
OF THE LANGUAGE].php 
or for example /include/texts_en.php for English. The language file 
contains the different messages as PHP variables, for example: 

$M_HIDE_RECENT_SEARCHES="hide recent searches"; 
$M_CLEAR_ALL="clear all"; 
$M_SEE_ALL="see all"; 
$M_WEBSITE_HOME="Website Home";  
… 

Translating the language file consists of translating the messages en-
closed in brackets to the right, for example for Spanish: 

$M_HIDE_RECENT_SEARCHES="ocultar búsquedas recientes"; 
$M_CLEAR_ALL="borrar todos"; 
$M_SEE_ALL="ver todos"; 
$M_WEBSITE_HOME = "Sitio Web - Inicio"; 

In order to add a new language on the website, it's necessary to add 
the translated file in the /include folder and also the administrator has 
to use the form on the Settings → Language Versions page and enter 
the name of the new language for example “Deutsch” and the code for 
the new language, for example “DE”.  
The language code shows up after in the page links and is also used to 
for the name of the language file (in this case the language file will be /
include/texts_de.php) and it's important to be 2 characters (like EN, 
DE, PT, TR etc). 
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5. Front site templates man-
agement 

5.1. Templates overview 

A template for the front site represents a standard HTML code mixed 
with some special  WebSiteAdmin tags (the compatibility with the 
WebSiteAdmin template system, makes possible the usage of tem-
plates and features from other products using it, as well as combining 
different scripts and software products to work on one website).  

A front site could be either set as a file called “template.htm” in the 
main website folder or it can be set from the administration panel and 
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the Templates → Modify page. If both are available, then the template 
saved as a file “template.htm” will be used (it has higher priority). 

You may fine below a brief description of the template system and 
tags and check also 6.3. Custom HTML tags to see how you may create 
also your own custom tags with custom php files and code executed 
for them. 

When the different page are rendered on the front site, these special 
tags inserted in the template are replaced by the corresponding con-
tent - let's consider the following example with a simple template: 

<html> 
<head> 
<meta> 
<title><site title/></title> 
<meta name="description" content="<site description/>" /> 
<meta name="keywords" content="<site keywords/>" /> 
... 

When the page is rendered, for example the tag <site title/> will be 
replaced with the page title (in general the page titles can be set by 
the administrator from the Website →  Management page), so 
<title><site title/></title> will become: 

<title>The page title will come here</title> 

Please note that presence of none of these tags is obligatory, so you 
could combine them as you wish in order to create the website and 
layout suiting the best your specific needs. Be aware also that Web-
SiteAdmin allows you to create your own tags (from the “Custom tags” 
in the back office) and set php files created by you to be executed and 
the generated content to be used in real time to replace the tag with it. 
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Here are some most common tags used in the default templates of the 
different scripts based on WebSiteAdmin: 

<site title/> - Title of the web page  
<site description/> - Meta description of the web page  
<site keywords/> - Meta keywords of the web page  
<site menu/>- Main navigation menu of the website  
<site languages_menu/> - The languages menu of the website  
<site content/> - The main content of a page  
<site form/> - The custom server side forms for this page if there are 
any  
<site logins/> - The main log in form of the website 
<site quick_search/> - The quick search form on the front site 
<site news/> - The news (the administrator can manage them from the 
News page in the ADMIN) 
<site featured_ads/> - The block displaying the featured ads 
<site bottom_menu/> - The bottom menu displayed at the bottom of 
the site (it contains the same items as the main navigation menu) 

Please note that depending on the current product or script you are 
using, not all these tags may be available on it. 

To see your current template, the tags in it or modify it, please go to 
Templates in the administration panel. 

5.2. Adding new templates and modifying the existing ones 

In the Jobs Portal administration panel you may find the following 
pages related to the front site templates management: 

Templates → Select a Template 
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The page offers the possibility to the administrator to select a template 
which will be used for the front site between the currently available 
templates. Please note that in order to be able to select a template for 
a given website, you need to add first the template (if it doesn't still ex-
ist) 
 
Templates → Add a New Template 
This page can be used to add new templates to the website. The ad-
ministrator can add the new template by directly pasting its HTML 
code. 

Templates → Modify 

On this page the administrator can see the available templates and 
modify a selected template. In order to select a template for modifica-
tion, the administrator should click on the Modify icon and then a new 
text area having the full template code will appear.  

5.3. Custom HTML tags 

The custom HTML tags provide a great way to expand the current 
functionality by creating your own php scripts to be executed and the 
content they output to be shown precisely in a selected position by the 
administrator. 
This can be for example a php script calendar_tag.php showing a cus-
tom calendar, which needs to be added at the top right corner of all 
pages of the website. 

Creating a new custom tag is simple - the first step is to upload the 
corresponding PHP file in the /extensions folder on your site.  
Please note the file names of php files, which will be used for tags 
should end with tag in their name – for example calendar_tag.php or 
news_tag.php etc. 
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Then from the Extensions →  Tags page in the administrator panel, fill 
the tag name (for example: calendar) and click on the Add button. This 
will create the tag - <site calendar/> in this example and it will appear 
on the Tags page. 

The tag should be defined from Extension → Tags and then inserted in 
the template or in the page content. When the page is rendered all the 
custom defined tags will be replaced by the content generated by the 
script you set.  
The Tags page shows the current tags with their name, html code, the 
file to be executed (with a drop down listing all the uploaded tag files 
in the /extensions folder and a small delete icon allowing to delete the 
tag). 

The final step when creating a new tag is to associate your tag with the 
php file you uploaded – this can be done by simply selecting the file 
from the File dropdown (“calendar_tag.php” in this example) and click 
on the Save button at the bottom of the page. 
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fter doing this, you can start using the tag by inserting it in the front site 
template (from Templates → Modify page) at the position you prefer in 
the template.  

5.4. Adding Google AdSense advertisements or Google Analytics 

Very often the administrator may need to add external HTML code on 
website, it can be for example the HTML code for Google AdSense or 
other type of advertisements or Google Analytics code or a code pro-
vided by Google WebMaster Tools to verify the website. 

Such HTML codes need to be pasted in front site template, which can 
be done from the Templates → Modify page in the administration 
panel. On this page, it's necessary to click on the Modify icon – this will 
show the HTML code of the template and paste the piece of HTML 

code for the banners, Google Analytics or similar. 
When adding a counter or other tracking code like Googl Analytics, 
usually the best it to place it at the end of the template, for example 
just before the closing </body> tag. 
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For the advertisements the position will depend on what position ex-
actly in the template (for example, top or bottom or to the right of the 
website pages etc.) the administrator would like to add them. 

If you experience any difficulties when doing this, please don't hesitate 
to contact us and our support team will try to assist you asap. 

6. Administration panel users 
and groups 

The administrator has the possibility to create additional user groups 
for the main administration panel, add users in them and assign their 
permissions. This can be done from “Users” in the administration pan-
el. 
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This functionality can be used if for example there are multiple persons 
working on the website (for example person A validating the listings 
posted by the users, person B responsible for the design of the web-
site and templates management, person C adding news on the web-
site etc.) 

6.1. User groups 

The user groups make easier the permissions management for the 
users – instead of setting individually the permissions for every users, it 
can be be possible to create different user groups, add the users in 
them and manage the permissions per group. 
For example, it can be possible to create a group of users who will be 
responsible only for posting news on the website “NewsAdministra-
tors” and won't have access to the other pages like the ones for vali-
dating the listings etc. 

To create a new user group, the only field the administrator has to fill is 
the group user name. 

 

The page shows below also the list of the groups with their ID and a 
check box allowing to select one or many groups and delete them. 
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6.2. Adding new users 

To add a new user, it's necessary to click on the New User button at the 
top of the User Groups page or choose directly from the main start 
menu Users → New User. 

When adding a new user, it's necessary to select its Type or User 
Groups between the ones added by the administrator, enter his user-
name, password, phone and email. 

 

To see a list of the current users or modify their information, it's neces-
sary to go to the Users List page (can be selected from the start menu 
Users → Users List or using the top buttons while in the Users category 
in the administration panel) 
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6.3. Permissions management 

To set the permissions for the different user groups, it's necessary to 
go to the Users → User Permissions page in the administration panel. 

The page shows a list of all the pages available by default in the  ad-
ministration panel and a check box for every box – to grant a permis-
sion for a selected page, it's necessary to check the box for it and 
when when ready, to click on the Save button at the bottom of the 
page. 

his will save the permissions sets for the user group. 
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An user, member of an user group, which has been granted access to 
only some pages in the administration panel will see just these pages 
in the menus when he logs in. 
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